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» Download GGl

e JAVAisrequiredin your computer. You need to
download the Imagine (PDF based) version at:
https://tb.plazi.org/GgServer/Downloads/Gglmagine-
Default.imagine.zip

e Then you need to unzip it directly where you want to
have the software installed. For example, the root folder
of the C: or D: drives



https://tb.plazi.org/GgServer/Downloads/GgImagine-Default.imagine.zip
https://tb.plazi.org/GgServer/Downloads/GgImagine-Default.imagine.zip
https://tb.plazi.org/GgServer/Downloads/GgImagine-Default.imagine.zip

» Installing and opening GGl

e After that you need to update the software by opening it
once, because the version on the website is not the
latest version.

Open “Gglmagine” application and allow its acces to the
web

| £ Gamta Executable Jar File 1,789 KB

|£:| Gamtalmaging&PI Executable Jar File 174 KB

[%=] Gglmagine Windows Batch File | KB Allow Web Access? X
| Gglmagine.cnfg CMFG File S0 KB
| Gglmagine.cnfg.2023-04-13-17-31-10.0ld QLD File S50 KB 0 Allow GoldenGATE Imagine and its components to access the web?
| Gglmagine.contextMenu.cnfg CMFG File I KB

» B Gglmagine Application T3 KB Yes No

| £ Gglmagine Executable Jar File 662 KB t
| Gglmagine.menus.cnfg CMFG File 4 KB
| Gglmagine.pdfDecoderCharset.cnfg CMFG File I KB

[%] Gglmagine Shell Script | KB

A\ 4



» Installing and opening GGl

o Select “Default.imagine” with the Plazi server option

. Select Gglmagine Configuration x
Please select the configuration to load.

Config Mame Config Host Last Modified
|L|:u:a| Master Configuration Local 2025.03.19.11.40

Local 2025.03.10.14.34
‘https://tb.plazi.org/GoServer /GgCo... |2025,03.15.06,49
ServerBatch.imagine https: //tb.plazi.org/GgServer /GgCo. .. [2025.02.03.15.25

De

Ok Cancel Make Master




» Installing and opening GGl

e You should get to this screen

Bl GoldenGATE Imagine - Default.imagine — O X

File Export Edit Undo Tools Help Page 0 of 0 100% « |Pages Top-Down




» Log in to GGl

e The First action is to log in GGI

Click on “File” -> “Load Document from GoldenGATE
Server”

Choose the Plazi account and click “OK”"

Fill your username and password (provided to you by
Plazi team)

After logged in, you can cancel the “Open Document
Directly” box that appears, asking a Document ID




» Log in to GGl

. GoldenGATE Imagine - Default.imagine
File Export Edit Undo Tools Help

Open Document
Load Document from URL
Load Docurnent from GoldenGATE Server

Save Document
Save Document As

Save Document to GoldenGATE Server

Close Document

Exit

Select Pages

| % P

Select Account
Loal

—
e 3

Please select the account to use for connection.

TR https: /ftb.plazi.org/GgServer foroxy: 443 (via HTTP) -

. Leg in to https://tb.plazi.org/GgServer/proxy
Please enter your login data for the GoldeGATE Server at https://tb.plazi.org/GaServer fjproxy

et

User Mame Ijonas Password |o-oo--|

["] remember User Name [] change Password

OK Cancel |




» Opening a document

e To open document from local device, click on “File” ->
“Open Document”

Choose between opening a PDF (born-digital or scanned)
or an IMF File

. GoldenGATE Imagine - Default.imagine
File Export Edit Undo Tocls Help
Open Document

Load Document from URL

Load Document from GoldenGATE Server
Save Document
Save Documen t As

Save Document to GoldenGATE Server PDF

Close Document

Exit

Select Pages



http://plazi.org/data-apis-tools/image-markup-file/

» Opening a document . ><

General PDF Loading Modes

Because PDF documents vary widely in the nature of their content, GoldenGATE Imagine has different modes for decoding them:

. Open x # PDF documents: Generic mode, lets the PDF decoder determine which of the four more specific modes (below) to use,
" ‘based upon an overall assessment of the PDF. Use this only if you are uncertain about the nature of the PDF at hand.
? 4 m' @ PDF documents (born-digital): For born-digital PDFs, generated from text written in text processors or layout software.
All bitmap images are considered illustrations.
# PDF documents (scanned, with or without OCR): For PDFs that bundle scans of the individual pages of a paper-based
document. Any OCR embedded within the PDF can be used, and the exact positioning of the individual words can be

Look in: Learning -

| | 1981-Article Text-8679-1-10-20221122.pdf.imf
| | Candollea.76.1.117-123.pdf.imf

L=

Recent Items adjusted to fit the text in the underlyving scans as closely as possible.
# PDF documents (scanned, text layer digitized): For scanned PDFs in whose scans the text layer has been completely
Options for Font Decoding replaced (as opposed to supplemented) with OCR output, basically producing a PDF whose text renders like in a
- ‘born-digital one, but onto the backdrop of scanned page backgrounds. In particular, there is no actual scanned text anymore
Decode Unmapped Glyphs to anchor the OCR to.
Desktop Default Charset # PDF documents (scanned, text layer vectorized): For scanned PDFs in whose scans the text layer has been replaced

with PDF vector graphics, with the latter bundled into special PDF fonts, i.e. DjVu compression.
Options for Scanned PDFs

Use Embedded OCR Options for Font Decoding
Documents
Adjust to Blocks
| Rendered text in born-digital PDFs 1s mostly represented i the form of strings with 8 bits per character, so representing Unicode
[a FETELETE characters outside the ANSI range requires a custom arrangement of the characters in the fonts embedded in the PDF. To accurately
— Expect Meta Pages map such custom encoder characters to their corresponding Unicode points, fonts embedded in PDFs provide a Unicode mapping
This PC data structure, intended to facilitate accessibility features like Braille output or text-to-voice, and also to support accurate copy&paste.
Scanned Page Format
Auto-detect However, this data structure is not always present, and sometimes incomplete. On top of that, since most PDF viewers use any
i given Unicode mapping as the basis for copy&paste operations . an intenfionally erroneous (often chaotic) Unicode mapping can also
Single Pages > /“' be abused to effectively foil copydrpaste operations by reducing their result to complete garble.

Double Pages ‘,/
r To overcome these latter obstacles (if present), the PDF decoder has various modes of approaching embedded fonts. In general, if
Fix DPI ¥ the Unicods mappings in a given PDF are known to be good and accurate, a more trusting approach is perfectly fine, and also
Help | requires less computational effort. On the other hand, the more computationally intensive approaches can overcome a much wider

range of shortcomings and obfuscation techniques. The particular font decoding modes are:

Ferm= ‘ # Do Not Decode Fonts: Takes any given Unicode mapping at face value, supplemented with the raw $-bit values from the

Files of type: TrEre T R PDF strings, not even rendering the glyphs. This mode cannot determine font style (bold, italics) or the type of a given font
(serif vs. sans-serif vs. monospaced) bevond hints from the font name. This mode is mostly good for basic PDF to text
Image Markup Files - conversion

Image Markup Directories

Batch Cached Documents

FDF Documents

PDF Documents (scanned, with or without OCR)

FDF Documents (scanned, text layer digitized)

FDF Documents (scanned, text layer vectorized) W

@ Render Glyphs Only: Takes any given Unicode mapping at face value, supplemented with the raw 8-bit values from the




» Scanned documents

e Depending on the quality of the scan, the OCR will be
better or worst

e Remember to select “PDF Documents (scanned)” when
you open the file in GGI

e Move the “weight of OCR” bar (close to the “word” box
in the Display Control) to the right to be able to fix OCR




» Scanned documents oo

[l word &

| Percentage weight of OCR text on top of page image
T T

croisement de la ligne médiane avec le bord antérieur de l'aire frontale externe.
Les quatre taches triangulaires du mésonotum sont équivalentes el 'on retrouve
quatre macules rondes également trés semblables entre elles en avanl de I'éléeva-
tion cruciforme, Dessous du thorax couleur noisette, de méme que les pattes
Opercules jointifs, le rostr¢ dépassant de pew le point de jonction postérieur,
Abdomen bistre, légérement plus clair sur les cymbacalvptes. Muaculature apicale
des homélvtres plus délice que chez T giovanndimae ;| coloris moins constrastés
sur 'aire apicale des ailes postéricures dont une teinte brigue occupe principit
lement I'aire basale

IMmmensions  Longueur du corps = 32 mm ; envergure — 98 mm ; largeur de
la| Dimensions Longjueur du corps = 32 mm , envergure = 8 mm ; largeur de
1 [JBeold []Italics |Symbols

Dimensions Longueur du corps = 32 mm ; envergure = 98 mm ; largeur de

inetss vicihloe da nendil [Meite ¥ nartienlidesment rohneis meaiec nreodnicant dec Tnhes




» Opening a document

e To open IMF File from Plazi server, using UUID found in
the TreatmentBank publication page

Click on “File” -> “Load Document from GoldenGATE
Server”

You need to log in GGl if you still did not do it



http://plazi.org/data-apis-tools/image-markup-file/

» Opening a document

tb.plazi.org/GgServer/summary{D51BB22BFFIBFFOCH 2F851TFEGSAEZF

. GoldenGATE Imagine - Default.imagine
File | Export Edit Undo Tools Help

uuiD

Load Document from URL e 3
Select Account >
Loa

Open Document

Load Document from GoldenGATE Server

Pleaze select the account to use for connection.
https: /ftb.plazi.org/GaServer jproxy:443 (via HTTP) ~

Save Document

Save Document As
Save Document to GoldenGATE Server I Cancel

Close Document f

Exit -
. Leg in to https://tb.plazi.org/GgServer/proxy X
Select Pages Please enter your login data for the GoldeGATE Server at https: //tb. plazi.ora/GaServer fproxy
User Name honas Password |nono|
[] Remember User Name [] Change Password
oK | Cancel |

I f
| . i (nt . S ebde S ATE O

. COpen Decument Directly hd

Enter document ID to load a spedific document directly, or proceed to document list.
Document ID: |D51BE22BFFOBFFACF 12F8517FESIAEZF

Show List | Load | Cancel | Fetch Mode

T t=| T




» Annotations in GGI

e As we use the tools for individual extraction, new
annotations are added to our “Display Control” (at the

right side of your view)

o In Order to Work Display Control

O word

with them, they et
need to be ticked

block
column
image

line

| paragraph

region

| table

tableCell

| tableCol

N O I A I A R

tableRow

Annotations

Show All Hide All

(I O A
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collectionCode

specimenCode |
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subSection

subSubSection |

superscript

| tableCitation |

| taxonomicMame |

| taxonomichameLabel |

title
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typeStatus

volumeTitle

year ‘v
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» After loading document

Kalanchoe darainensis (Crassulaceae),

a new species from northeastern
Madagascar

David-Paul Klein; Ronen Shtein| Louis Nusbaumer & Martin W. Callmande ‘

|Abstract

RLLINE P& R SH T
Lonhewserd Madugusenr Lz

S LN USBAUMER 8 MW CALLMANDLE (20210 Kakilchos duruilersis Cras
doed 6 17027 L Ligliskd Kiglish nld Urefeh tbstracis DOT bup sdviong 11,1535,

202176 Ll 2

Alew species ol smalld rosulate al'd upright-lHlowered Kalonchoe Adals (Crassiduceas from lortheaster] Madagascar
is-deseribed-ald-llusirawed -Kalanchod deratnensis 117 Kleil-de Callm Morphologicallyse Kelanehos darainensis is most
similar ta-Kolanchoe blosstetdiand Poellll al'd Kolunchoe iobubifero H Perried which-are KUowl Troni the Torthwesterl
Tsaratalaly Massilé o100 km southwest ol Daraita Detailed Totes ol the habiat ald ecolowy ol Kolanchoe derainen.
arel providedde as well s @ shorl lasolomical overview ol allied specied bl the Kelarehod subgl Kelanchoe lmom Madagascarke
ilcludile all ideltilicaiol hey ta those species: Despite it restrivied distributiol il the protected Allsahabe massil the
{ew species s prelimil ary-assessed as Least-volcerT [LC usil g the ITUCN Red List Crileria

RLLIN [P RESHTLEING TN USBAUMER & MW/ CALLMANDLR U218 Kulalehod Uanilelss s & ube Touvells spice
G Cameeedied TEN02E FF el s 2 DOT hiti dained 101555342020 76151

s du lord-estde Madagascar
Kealannehoe darainensis 2st plus

Ule louvelle espece de Kalanchoe Adals Wrassmlaceacd pelitedd rosuléeetu fleurs dress:
estléerite et illusirée Kelonchoe daraimensis 13- Kleil et Callm Morphologiguemel i
proche de Kalanchoe Slossfeldivne Pocllll et Kalanchoe globidifera H Perrier yui soltcolTues du Tord-ouest du massil
Tsaratalalud o T0C ki o sud-ouest de Daraili, Des Toles dé sur Phabitat et Pécologie de Kalanchoe darcainen:
ilsi-guulbrel apercy laxol omiqud des espices allides de- Kelarched subg-Kalenchod de Madagascardy -y
es Malerd sa distributiol restreilte dal’s e massil pros dAlsahabed

CRASSULACEAE = Ralanehos = Madagascal - Daraifa - Tokv-Mafambato - New specie:

[Addresedi hebuibor?

E-mail david-paulklein wograr hu-berlin g4

L MW Coleervan
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]
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Candollez 76 2021

H il 18- A new specles of Kalanchoe {Cre i from

fintrodustion]

The-sefus Kalanchod Adats [Crassulaceai- Kaianchooideac |
comprises more thaf 156 species kfowf 1o date afd occurs
i Madagascar& Africad Arabig afd tropical Asia Curreftly
8(t-species-atd fothospecies-ure recoefized it Madagas-
car’-all-but-ofe bf-which-are-efdemic to-the Great Tslafd
MADAGASCAR CATALOGUEE 20217 The pefus of Kalanehor
cofsists of three subgeferal the autofymic Relanchioe subg
Kalanchae which is-kfowt From Madaeascan®-Africai Arabia
afd hsink as well as Relanchos subg Bryophyllwsi (Salishi
Koorders afd Kalonches subg Kirchingid |Baker! Gideof I
Sm & Fieueiredod hoth-efdemic 1o Madagascar {SMITH-&
FIGUEIREDO 201 8]
Ralanchoe subg Kolanchoe ifcludes species that share the
followifs characters plafts atfual vr pereffial& herbaceous or
woody-arboresceftd calve-nffused for most-of irs-lefath with
a short Lo ifdistifet kel sepal sezmefis oftef freall usually
adpressed L0 the corolla lube& filamefts ifserted = above the
middle bf the corolli uhal rareh el flowers typical v
rarely-nmfi-direc 1or-pefdefid leaves afd ifflorescefe
Fever bulbiliferousi carpels cofverseftd usuallv much ofger
that the stles& seales elof gated Lo lifzard with i lefarhiwidth
ratio-isually->“tafthers ifeluded if-corolla-tihe or-very
slightly exserted& oftef dressed with a & spherical coffective
glafd of the afthers [BOTTEAT & ALLORGE-BOTTEATLG 1995
DESCOINGS& 2003 SMITH & FIGUEREDOE 2018

Amofe the Malagasy represefiatives of Kolanckod
Kalanchoe| several morphologically similar species werd his-
torically placed it "Group 137 of RAYMOND-HAMET 11907 1|
su-emphasize the- morphological similarities they share with
species ifdigefous 1o maiflafd Africs coftrast Lo similari-
ties shared with nther species From Madagnscar These species
are K boisit Raym HametS& H Perrier K biareenii Rayim
Hametd K chaporom Ravm-Hametd Kl olobwiifera H Perrier
afd K elobudifera var cocemed Hi Perrien (= K bossfeldinno
Poellfy Laer® BOTTEAU & ALLORGE-BOITEAU {1995 afd
ALLORGE-BOITEAU-I1%96]-proposed-la-Further-subdivide
these species iftol the Lwa ifformal aroups "Occidefales afd
Gilobuliterne’ & alofe with Kl aromaiica H Perrier K bowcverii
RavmH net-& H Perrier-afd Kl fancealar [Forssk | Pe
The-proup Globuliferae’ was defifed hased of the spherical
coffective glafds Falobules”™ of the pfihersd whereas species
placed if "Occideftales” have termifal ifflorescefcesd ure
plafdular-pilose [except K Wossfeldionaaf d-de-fot-have the
aforemeltiofed coffective glafds Howeverd they added thai
the latfer grour "fe présefte pas beaucoun d'homogeréie’
daFor preseft-much-homogefein TROITEALN& ALLORGE.
BOITEAUS 19951870 They-alse-ufderlifed the morphological
affifity of both groups W some coftifeftal Africaf species’ is
opposed Lo other Malagasy represeftatives of Kalanchoe subg
Kalanchoe-such-as-the-species-they-placed-if-the-ittarmal

Fig 1~ Distritution map a1 Kalanchos daramensis D Kisin & Callm
Imap derived fram open data sources nitos earthdalanass ooy
DpenSiresibant anc MOAT 3 SMITH 2007

Lafigerae” groun

Lxcludile Ralurchoe sromaiics al'd K bowvetii thal Bave
omlidirectivlal & sy gomorphic-Llow ald-distilci-corolla
cx ol bothrilTormal-soupsé "Occi-

re small sialured shrubs o' medium sized herbsk usually
at-leasl-partially-covered-with # glaldular- ildumel e that
have ereel actilomorphic Mowersé highly reduced toildistilel
wailya wbesd Lol gl deltodd tofarrowly lalceolate sepalsd apically
acute fogeumlale ald-lilear to lilornrlectary scales Twaoy
Turther recelty described speciesd K ansenni fered Dese ald K
pareikiond | Yesc & Lavralos cal also be placed il this species
sroupdt based LI their morpholugy Kalanchoe anienniferd origi-
Tates froni-the-vicilily - bl-Alsalove il -the Tsiley de Bema-
hara il wester] Madagascar !Malgelsdorl T8 pers comm |
Lhe prey Lvpe locality was ulk fowl to DESCOINGS (2004 ]
who-staled TAlnca™ il the protwlogue - Morcoverk despile-its
occurrelve il Arabiag virtually neross coltileltal Altcaf ald i}
Madagascar® the 2xact Tatural geographical distributiol ralee
ol Klanceolaia remails opel 1o coljeclure Kalanchor fanceoluse
rather-shares characler expressiols with species nl-Kalanchoe
subigl Kalanchee Trom bevold Madagascar al'd accordilgly we
relrail froni placile it il this Otherwise Malugasy sroup
[ Durilg ifveliories ol the Daraila regiol (Tow called
Lok y-Malambatods see PHILLIPSON 21 2[& 2018 & Tour-speci-
e ls of small& rosulateds elafdular piloscd succulelt plalts
were collected il the massil ol Alisahabe (Figl 1) These
specimel’s-have the erect Howende litear (o liliform fectary
sealedd apically ilserted Tilamel'ts al'd reduced calyx lube that
are Lould il represellatives vl Kalanchoe suby Kalanchoe afd
were ullorigilallv determiled bs represeltile K pumila Baker
Howeverk K pumita difTers from the tollected specimel’s by
beifg taller 120=30 cm afd loury-pruifosed by lackifs af
ifdumeltumds ald by havilg lrgel pifk-coloured& tampalulate

corolla-tubes (BAKER 1884 BOITEAU& A.LL[)RGE-BO]TEAL&;HIH
I
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» After detecting document structure

Kalanchoe darainensis (Crassulaceae),

a new species from northeastern

Madagascar

David-Paul Klein; Ronen Shtein, Louis Nusbaumer & Martin W. Calimander
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The zefus Kalanchos Adals 1 Crasswlaceacs Kedanchovidear |
comprises-more-that- 130 species kfowt 1o date af d-oecurs
if Madagascarfe Africa& Arabia afd tropical Asia Curreftly
8-species-afd fothospecies-are recogtized it Mada,
wrf all but ofe of which are efdemic [0 the Great Islafd
MADAGASCAR CATALOGUFS 202 1)y The gefus of Kalanctio:
cofsists hf hree subgeferal the autofymid Kelanchad subg
Kalanchoe which is kfowt From Madagascan® Ariead Arabia
afd Asiskt s well a8 Kalanchos subg Bryaphyilus {Salishi
Koorders afd Kaloichor subg Kirchingia [Baker| Gideot I
Sm & Figueiredo& both efdemic 1o Ms car [SMITH &
FIGUETREDO-20 1§

Kalanchoe subg Kolanchee ifeludes species that share the
Followifg characters plafts affual b pereffiale herhaceans o
arhoresceftd rx uffused for most of its lefgth with
4-short o ifdistifet hek sepal segmefts oftef freakl nsually
adpressed-w-the-corolli-ubed: filamefts ifserred hove the
middle bf the corolli rarely helwit Flowers by pically

Fever hulhiliferousé carpels cofvergeftd sually much lof ger
thaf the styles& scales elof gated Lo lifeard with i lefgthiwidth
ratio-nsually > afthersifeluded it corolla-tuhe-or-very
Slightly exsertedi@ nftef dressed with 4 & spherical coffective
alafd-of the afthers (BOTTEAT & ALLORGE-BOTTEATE- 1995
DESCOINGS& 2003 SMITH & FIGURIREDOE 2018y

Amofg the Malagusy represeftatives of Kalanchae subg
Kalanchar -several morphologically similar species werd his-
torically placed 1 7Group |37 pf RAYMOND-HAMET 11907 Lo
s emphasize the morphological similarities they share with
species-ifdigefous lo-maiflatd Africaf it cofrrastwwim
‘ties shared with nther species froni Madagascarl These species
(are K boisii Rayml Hamet & H Perrier. Kl brigueri Raym-
Hamet K. vhapoiors Raym-Hamer& KL glabuiifero Hi Perrier
afd K1 elohulifera varl Locctnee Hi Perrier K Blassfeldians
Poellf i Later BOITEAD-& ATTORGE-BOITEAU- 1995 -afd
ALLORGE-BOITEAT] 11996} proposed Lo Further subdivide
these species ifto the lwarifformal-roups Occidefrales” afd
Globuliferse & alofg with K aromatica HU Perieid K howy
Raym-Hamet & H Perrier af d K lanceoloa [Forssk | Pers
The proup “Glohulferae” was defifed hased of the spheri
coffective ds globules™; of the afthers& whereas sp
placed-if 10 leftales’have termifal ifflorescefcesd re
‘wlafdular pilose fexcept KL blosifeldianad afd da fot have the
aforemeftiofed coffective plafds Howeveri they added that
the latter group “fe présefre pas heaucoup d homogeéféiré”
da fot preseft much homogefeity [BOITEAL & ALTORGE-
BOITEAUA- 199511 87 They-alsa-ufderl ifed-the-morpholo;
affifiny-of-hoth-groupsto some coftifeftal Africaf specie
oppesed Lo oiher Malagasy represefttives of Kalauchos subg
Kalanchoe such-as-the-species-they-placed-if-the-itfarmal
fiLafigerae’ group’

Tl

7

BRODTE:

v choe-dromalicd 1l'd Kibenvedii thathave
omlidirectivlald 2y gomorphic-Howens ald-distile eorolk
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» After adding document metadata

[Kalanchoe darainensis (Crassulaceae),
a new species from northeastern
Madagascar|

David-Paul Klein/Ronen Shtein Louis Nusbaumer &|Martin W, Callmander
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» Images or graphics
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Bl Edit Attributes

image image at [142,1446,866,1671] on page 2
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caption FIGURE 1. Map showing the ... Cosmianthmemum melinhense
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» Tables

Petiole length

Leaf surface

Lateral leaf veins

Inflorescence

12— 15 mm. pubescent

adaxially glabrous, abaxially
pubescent along the veins

7—1(}pairs

compound-dichasia in

terminal or axillary, axis

glandular, 7-10¢m

3-10 mm. pilose

adaxially pilose toward base
oralong veins, abaxially

alabrous

57 pairs

thyrses terminal. 3—10cm

long

-32 mm| glabrous

adaxially glabrous abaxially
puberulent along veins and

margin

#=10 pairs

thyrses terminal. thyrsoid!

interrupted. 20-60 ¢m long

10-25 mm., pubescent

both surfaces glabrous

51 pairs

thyrses terminal 4—10 cm

long

| table |
tableCel
| tableCal |
tableRow

Morphological Cosmianthemum Cosmianthenmum Cosmianthemum Cosmianthemum . Edit Attributes X
characters melinhense guangxiense knoxiifolium viriduliflorum caption TABLE 1. Comparison of Cosmianthemurn ... morphologically allie. ..
|
| IE ID-Table-UUID: F5F42BCDFFIDFFIAF 1A78589FADFAEST
Habit herbs 0.3-0.6 m tall herbs up to 70 cm tall shrub, 60 cm tall herbs, up to 60 cm tall X/| httpUri: http://table. plazi.org/id F SF42BCDFFADFFIAF 1478 589FADFAES
‘ X|| startld: 6.[136,229,158,134]
X | targetBooc [144,1432,212,2061
. subterete, pubescent when | [4-angled to subterete, sulcate) o [144,1432,212,2061]
Stem = —_— terete, puberulent terete, glabrous X | targetisTable: true
B o] - asC
‘ young | soon glabrous sparsely pubescent X| targetPageld: &
Leaf size 12-16% 4-6 cm 2-13.5x 1.4-4 cm B-20= 1.8-7.3cm 7-15x% 4-9cm
‘ Attribute Mame « Add [ Set Attribute
. ovate-elliptic to oblong- elliptic-lanceolate 1o |Attribute Value i
Leaf shape elliptic to ovate, lanceolate - . - ovate ta broadly ovate
lanceolate lanceolate Previous oK Cancel




» WordFflow

e Fixing wordflow

Check the “word” box (mandatory). Cut the stream when
needed and make the correct links.

You can use two combination of functions:
- "“Cut Stream Before” + “Click Predecessor”
- "“Cut Stream After” + “Click Successor”




» WordFflow
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List Cate Make Stream ut et stream e 1tinsfi;] (
OR
Cut Stream Before onger stamin Set Previous Word Relation  *
Cut Stream After ~(Benoist 19 Cut Stream Before

AN D Click Successor

|Cut text stream after | 1 Make Stream

Click Successor | Markwurds and set its successor by clicking another word I_
Set Text Stream Type
Make Strearn

Click Predeccessor
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» Set Word Relation

e Set word relation between two words

Click in one of them and choose “Set Next Word

Relation” or “Set Previous Word Relation” and select the
appropriate option

P.S:

- Hyphenated word: syllables of the same word on
different lines

- Line-broken word: compound words separated by
hyphen, with each word on a different line




» Set Word Relation

The Me Linh Station for Biodiversity was established in 1999 unde
Vietnam Academy of Science and Technology to facilitate the k
Province of the northeastern region of the country (Fig. 1). The stz
flora It is home to numerous Vietnamese endemics and has rece
several new species were discovered (Kim ez al. 2015, Hai ef al. 2!
The cenuc Caocmianthemion Bremekamp (1960: 66) comprise
diversi en 1985, Hu ez al. 2011, Mabber
termin :landular-pubescent calyx. with k
corollz burple spot at base. slightly curve

2. inse slabrous anthers with thecae par
pubesc A » qmp I9GQ Hgnsen 1985. ScoFlan

Tl Set Previous Word Relation > Separate Word Dl
2000) Click Successor ® Separate Word with Pararaph Break Before ng
el al.2 Copy Text Second Part of Hyphenated Word “ ¢

| p = 3 ‘:

SLAMET  ShowXMLView of subSection | __.__>ccore ot o e Broken Word .l
being ¢  More.. ing an elongate. narrow. cylindric

2011, Deng & Gao. 2020) Prevnouslv only one species. C. knoxifol
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The genus Cosmianthemum Bremekamp ( 1960 66} compris
diversity center in Borneo (Hansen 1985 Hu et al. 201 1. Mabb
terminal. thyrsoid inflorescence; glandular-pubescent calyx. with
corolle wuith it loworlio bhavinn pyrple spot at base, slightly cury
2. ins glabrous anthers with thecae p:
pube kamp 1960. Hansen 1985, Scotl:

1 subtribe Justicinae by some auths
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el Al . Nt Word Relation ,ubtribe Odontoneminae (Deng e

stame Set Previous Word Relation > @ Separate Word a
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201 1 Copy Text Second Part of Hyphenated Word !-f
) ) Second Part of Line-Broken Word
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» Set Word Relation

mm long, 5-lobed: lobes linear-lanceolate, ca 4 x 0.5-0.8 mm, %ubequal apex acuminate. outside sparselv gland-l

Edit Annotation Attributes ... >

tipped pubescent: inside densely gland-tipped pubescent Corolla green-purple. 1.4-1.5 cm long. outside gland-tippe
pubescent: tube basally cylindric and 1.5-2 mm wide for 4.5-5 mm long: limb strongly 2-lipped. lower lip viole Remove Annotation .. N
dotted. 5-5.5 mm broad, 3-lobed. middle lobes bigger than laterals, middle ovate. ca 2.5 mm long, laterals oblong | Split trestrnent Before

1.5 x 2 mm: upper lip violet blotched. triangular, ca. 6 x 6 mm, 2-cleft Stamens 2. exserted: filaments ca 6 mm long [ SplitsubsubSection Before |
glabrous: anthers bithecous. thecae oblong ca 2.5 mm long. superposed. muticous at base: staminodes 2. linear. 2-2.5 [ iERcey

Copy Annotation Attributes ... ¥

| figure
O geoCo
O he:
O | journalC
O [ e
materia
[ B

mm long, glabrous. Ovary glabrous, green. [usiform with nectary flower disc bowl-shaped at base: style 910 mm . .o
long, glabrous. stigma slightly 2-lobed. Capsule clavate. 2.5-2.8 cm long sterile portion 1.2—1.6 cm long. puberulent  se previous word Relztion
Seeds 4. ca. 3.5 x 5 mm. ovate, scarcely compressed. pale brown, rugulose-alveolate | Click Successor

|[Etymology:—The species is named after the type locality, Me Linh Station for Biodiversity in Vinh Phuc Province Show XML View .

Separate Word

Separate Word with Pararaph Break After
First Part of Hyphenated Word

First Part of Line-Broken Word
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the 1293 species present in tree inventories. Our work has led to the recognition of certain taxo-
nomic and nomenclatural novelties. including a new combination in Lecythis Loefl. (Lecythidaceae |

Set Next Word Relation >

Set Previous Word Relation > Separate Word

Click Successor Separate Word with Pararaph Break Before

Copy Text | ® Second Part of Hyphenated Word
—— Show XML View of subSection Second Part of Line-Broken Word
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» Select regions or word strings

e There are two ways to select regions or word strings

- Click near a word (but outside it) and drag your cursor
around the word string to select it (region)

- Click in a word and drag your cursor over the words until
the end of the word string to select it (word string)

This is useful in several ways, like make new annotations,
and/or merge paragraphs, as you will see in this course




» Select regions or word strings

Selecting region

Taxonomic treatment

Cosmianthemun melinhense DV Hai, ZLILin & Y EDeng sp. nov. (Figs. 2-4)

Type—VIETNAM! Vinh Phuc Province! Phuc Yen Town-Ngoc Thanh-commune! elev.ca. 152 ml 21
October 2016, Do Van Hai! Trinft Xuan Thanh. DVH 149 (holotype HN! isotypes HNL IBSC)

Selecting word string

Taxonomic treatment

Cosmianthemum melinhense DV Hai, ZL Lin & Y F Deng, sp. nov. (Figs. 2-4]

Type—VIETNAM. Vinh Phuc Province: Phuc Yen Town Ngoc Thanh commune: elev. ca. 152 m.

https://tb.plazi.org/GgServer/summary/D51BB22BFFOBFFOCF12F8517FE69AE2F
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» Merge/split regions
e Merge paragraphs/blocks

Select the regions (or just a part of them) and choose
“Merge ‘paragraph’ Regions” and/or “Merge Blocks”

e Split paragraphs/blocks

Select just the region you want to split from the rest and
click on “Split ‘paragraph’ Region” or “Split Block”




» Merge/split regions

'Taxonomic treatment|

\Cosmianthemum melinhense D.V.Hai, ZLLin & Y.EDeng, sp. nov. (Figs. 2-4)

Type—VIETNA Mark Region > 1c Yen Town Ngoc Thanh commune! elev. ca. 152 m. 21°2351.3"N 10542756.8E. 21
Oclober 201 %"}mnh DVH 149 (holotype HN! isoty pes HNL IBSCJY
Revise Block Paragraphs

Taxonomic treatment]

Cosmianthemum melinhense D.V Hai, Z1Lin & YFDeng sp. nov. (Figs.2-4) Mark Region ’

Remove Regicn ... »

Typel—VIETNAM. Vinh Phuc Province: Phuc Yen Town. Ngoc Thanh commune!, elevi ca. 15 Revise Block Paragraphs ~ 4256.8"E. 21
October 2016, Do Van Hai Trinh Xuan Thanli- DVH 149 {holotype HN! isotypes HN! 1B Split Block
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» Merge/split annotations

e Merge annotations

Select parts of the annotations and choose to merge
them. For example, “Merge materialsCitations”

e Split annotations

Decide where the desired boundary will be, click on the
first word of the desired second annotation and choose to
split them before. For example, “Split materialsCitation
Before”




» Merge/split regions

|Cosmianthemum melinhense DN Hai, ZLLin & Y EDene. sp. nov. (Figs. 2-4]

Type:—[VIETNAM. Vinh Phuc Province Phuc Yen Town Ngoc Thanh commune, elev ca, 152 m. 21°23
[Octaber 2016, Do Van Hai. Trinh Xuan Thanh, DVH 149 (holotype HN - isotypes HN., IBSC ]

Find Mext '51.3 ... 2016

October 2016, Do Van Hai. Trinh Xuan Thanh. DVA 149 (holotype HN isetvpes HN/ 1IBRsC

Edit Annotation Attributes ...

Copy Annotation Attributes ...

Remove Annotation ...

[AHNEWSPECIES-ORCOSMIANTHEMUM{MELINHENSE——————PRVIG | it testiment Before
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Type—[VIETNAM. Vinh Phuc Province: Phuc Yen Town Ngoc Thanh commune. elev. ca. 152 m. 21°23'51.37N, 105°4256.87E. 21
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» Extend boundaries

e Extend annotation boundaries

Select a part of the annotation and drag the cursor until
the desired new boundary, then select to extend it. For
example, “Extend bibRef”

https://tb.plazi.org/GgServer/summary/D51BB22BFFOBFFOCF12F8517FE69AE2F
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» Extend boundaries

B e —

Co - oegegpw =t > I

Vietnam Annales Botanict Fennict 55 (4—6) 333-337

Hai, DV. Oanh. P.T. Deng. Y.E. Lin, ZL. Choudhary RK. & Lee. J K. (2018) Rungia khoit { Acanthaceae), a new species from northern

[https //doi ore/10.5735/085.055.0417]

1955197

Hansen, B. (1985) Cosmianthemum knoxiifoliuvm (C. B Clark

. Hansen comb. nov. (Acanthaceae} Nordic Journal of Bowany 5

Hai, D'V. Oanh. P.T. Deng. Y.F. Lin, ZL. Choudhary REK. &
Vietnam Anaedes Botanicd Fennici 353 (4=6) 333-337
lhitps //doi ore/10.5735/085.055.0417]

Hansen, B, (1985) Cosmianthemum knoxiifolivm (C. B Cla

1955197,

Extend bibRef

SR e e e
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Acanthaceae). a new species from northern

canthaceact Nordic Jowrnal of Botany 5
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» Set text stream type

e Select the string, click on “Set Text Stream Type"” and
choose the correct one. The main types are:

- mainText: all the main parts of the document, as head,
abstract, introduction, materials, results, discussion...

- pageTitle: page headers and/or footers, containing
journal name, volume, year, publisher, page number...

- footnote: page footers containing information about
something in the main text

- caption: caption of tables or images

- label: text inside images or graphics

- table: text inside tables




» Set text stream type

[FTGURT M ag Showing fhe fypelocalint by MR Ceen

Mark In-Line Caption

Mark Footnote
Mark Table Mote
|Taxonomic treatment] Mark Parenthesis
o Mekatft
\Cosmianthemum melinhense DN Hai, Z L. Set Next Word Relation i ®  caption
Set Previous Word Relation 1 deleted
- - Cut Stream Before footnote =
Tyvpe—VIETNAM Vinh Phue Province Phue Ye
r Cut Stream After label
October 2016, Do Van Hai, Trinh Xuan Thawnl Click Predeccessor 1
Click Successor pageTitle
IMake Stream table |
Set Text Stream Type : tableMote E

Crt Tevt Mirertinm »




» Mark captions and other annotations

e Mark captions

If they are not already marked, select the entire region for
the caption and click on “Mark Caption”

- For page headers or footers -> Select “Mark Page Header”
- For footnotes -> Select “Mark Footnote”

- For tables -> Select “Mark Table”

- For table notes -> Select “Mark Table Note”

P.S: This tool adds the annotation but also fix text stream
types automatically




» Mark captions and other annotations

[FIGURE 1. Map showing the type locality of Cosmianthmemum melinhense

[Taxonomic treatment|

Mark Region
Remove Region ...
Split Block

Mark Table
Mark In-Line Table

» | MekGopon

> Mark In-Line Caption
Mark Footnote
Mark Table Mote

|Cosmiantkemum melinhense DV Hai, ZLLin & Y .F Dengl sp. no'_ «

132 s Phytotaxa 538 (2) © 2022 Magnolia Press

HAI ET AL

Split Block

Mark Table
Mark In-Line Table

=3
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» New Annotation

e To create a new annotation, simply select the whole text
that you want to annotate and click on “Annotate”

If the annotation already exists and is checked in the
display control you can just select it in the list that
appears

If not, select “Annotate” again and manually add the new
annotation (check if the spelling of the word is correct)




» New Annotation

cams. Because 0l 105 narrow disiripuion witn an estmated population

= - . - Enter Annotation Type x
3 be Vulnerable [VU Fallouana tha TTTCN Rad Lict Caracnriac and (O
= needed to find add Annotate ’ Annotate ... Iy ( Enter or select type of annotation to create DOI +e v
Edit Annotation Attributes ... - bibRef x
lls more about the f Remove Annotation ... - caption Ste
1E . o Cancel
‘¢ necessary in the fu _ - collectingMunicipality
List "Vulnerable (WU)' ... e

Yaratypes)—VIET! |=ill

0qn " 4 Dol -
B TS -l
27E. 25 January 201 eley

- accessDate
January 2018, Do Ve HNJ pibid elev. ca 14 author
= : Set Text Stream Type > )
121, Do Van Hai. Noi 7o uan Thanh, DVH 399 (1 bibRef
: = =] bibRefCitation

s allied to|C. guang? St XML View . ,m Fang. et ‘j’j- (199742 bookContentInfo
& HSLoyHSLalin |, rom China in the chara caption
nd fruits. However. 1w aurers rrom k. virtaraiflorunt in having ellipt collectingCountry v

*Make sure there are no typos
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» Annotation attributes

e You can always “Edit Annotation Attributes”
Select the type of annotation you want to edit. Only
those that are toggled on in the display control will be
available to edit

e Option to copy attributes

You can copy the attributes from an annotation of the
same type and edit it afterwards




» Annotation attributes

\Cosmianthemum

|Type:—[VIETNAM . Vinh Phu

Edit Annotation Attributes ... E - treatment 'Cosmianthemum ... '

Copy Annotation Attributes ... 3

Remowve Annotation ...

Bl Edit Attributes

taxonomicame Cosmianthemum melinhense ... Hai, Z.L.Lin & ¥.F.Deng

_evidence: statusLabel

_step: newlabell

authority: D.V.Hai, Z.L.Lin &Y.F.Deng
authorityName: D. V. Hai, Z. L. Lin &Y. F. Deng
authorityYear: 2022

class: Magnoliopsida

family: Acanthaceae

genus: Cosmianthemum

kingdom: Flantae

order: Lamiales

phylum: Tracheophyta

rank: species

species: melinhense

EIEIEI BB E BN B EE

status: sp. nov.
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» Annotation boundaries

e Make sure the annotation boundaries are correctly
delimited

Expand, split or merge annotations
Always check if paragraphs are correct

Attributes may also be erroneously assigned depending
on the way the boundaries were set




» Annotation boundaries

Type:—[VIETNAM. Vinh Phuc Province: Phuc Yen Town Ngoc Thanh commune, elev ca. 152 m. 21°2351.3"N, 105°42'56.8"E. 21
October 2016, Do Van Heai. Trink Xuar Thanh. DVH {49 (holotype HN isctvpes HNL IBSCY
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» Remove annotations

e Select “Edit -> Remove Annotations” and choose which
one you want to remove from the document

It will remove all the annotations of that type present in
the document
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» Naming documents

e Use abbreviated names of journals, followed by volume,
issue and pagination.

It depends on each journal

FarEastEntomaol 402 1-36.pdf

RaflesBZ ool 68.369-373.pdf
FapAvZool 60.e20206039 pdf

PersJourAcarology.9.1.67-81 pdf

Candollea.75.2 241-244 pdf

TheColeopBull.74.4.367-646. pdf

ActaZoolAcad3ciH 66.1.23-33 pdf



https://library.caltech.edu/c.php?g=512744&p=4327657

» Saving a file

e "“File” -> “Save Document As” to save as IMF file
e "“File” -> “Save Document to GoldenGATE server” to save
straight to Plazi server
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